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OVERVIEW
SPB Wallet is a secure and manageable storage of sensitive information, such as passport and account numbers, 
access and PIN codes, logins and passwords. The encrypted and password-protected data can be accessed from 
Windows PCs, and synchronized with mobile devices. Available for Apple iPhone, Symbian S60 and Windows 
Mobile.

Software Features

Secure Storage for Sensitive Information
All of the data is stored in an encrypted password protected file. A strong AES 256bit algorithm is used for 
encryption. This means that the correct password has to be used to get access to any sensitive information. To be 
fully protected the following features are used:

 String AES 256 bit encryption. You can find more information about 
AES at: http://en.wikipedia.org/wiki/Advanced_Encryption_Standard

 Automatic wallet locking: If you forget to close your wallet OR if you 
leave your wallet open, Automatic Wallet Locking will automatically 
lock your wallet after the specified period of inactivity time.

Real Card Data Representation
SPB Wallet cards are designed to look like the cards we use on a daily basis. 
There are two ways to represent your data. The standard list with card field 
values and the real card graphic view (all the most important and useful 
information is represented in the graphic view).

Versions for both device and Desktop PC
SPB Wallet is available for Apple iPhone or iPod device and the Windows 
desktop. All features in the SPB Wallet are implemented in both versions. 

Importing Wizard from Other Wallets
SPB Wallet, on your Desktop PC, has the ability to import data from other 
wallet-type-applications, including: 

 eWallet.

 FlexWallet.

 CodeWallet.

 SplashID.

 Handy Safe.

 Custom CSV.

During the import, cards from other wallets are linked to predefined templates 
by a special matching engine automatically. All you need is just to provide the 

http://en.wikipedia.org/wiki/Advanced_Encryption_Standard
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exported file from another wallet to the SPB Wallet Importing Wizard and then follow the instructions.

Customizable Cards and Templates 
SPB Wallet provides improved card and template customization. You can customize the fields used in the template 
and their types, graphic view of the card template, font family and color used for the particular label, label 
position, card background, corners, etc. If needed, you can not only insert the graphic card view from a template, 
but customize the certain card view. Creation of a template based on another template is also supported. You can 
import and export templates, so as to share them with other users. You can also search and download at no cost 
templates or ask SPB Wallet team to make a new template for you at: http://spb.com/products/wallet/templates

Predefined Templates, Icons and Graphics
SPB Wallet not only gives you more than 60 predefined templates for all kinds of information you may need in your 
daily life, but also gives you lots of icons and graphics you can use for the creation of your own cards. Localized 
templates are also provided with the localized version of SPB Wallet.

Online Templates Gallery
SPB Wallet templates gallery is a large collection of over 7000 cards templates 
that can be downloaded and used at no cost. You can search for the templates 
you need. If you didn't find it you can request to make a new template for 
your card. 

Smart Card Fields
Quite often you do not need information as such but, you may in fact want to 
further use that information. There is a number of specific operations you can 
do with your card directly from SPB Wallet just by clicking the appropriate card 
field or choosing an operation from the context menu such as:

 Make a phone call or SMS.

 Go to a website.

 Send an Email.

Password Generator
The Password Generator creates random passwords that are highly secure and 
extremely difficult to crack or guess due to an optional combination of lower 
and upper case letters, numbers, and punctuation symbols.

Quick Search 
SPB Wallet provides the capability for a quick card search (by card name, 
notes, and fields). Please note that you do not need to press any button to 
start your search, the result is shown while you are entering your search 
criteria.

Backup 
Use the backup feature, on your Desktop, to make a copy of your wallet data 
so that this additional copy may be used to restore the original after a data 

http://spb.com/products/wallet/templates
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loss event. All backup copies of the wallet have a backup date/time part in their file names, so it will be easy for 
you to find a backup when you need it. If you want a periodic backup you can make a standard windows scheduled 
task that will do the backup periodically.

Integration with Internet Explorer & Firefox
The SPB Wallet, on your Desktop, toolbar for Internet Explorer & Firefox provides some features to exchange data 
between your wallet and websites. This feature makes your surfing on the web easier. These are: 

 Automatic card capturing to save user name and password of websites automatically when you sign in to 
any website that does not exist in your wallet.

 Capture card function. This feature can capture the entered user name, password, and URL the opened 
page and create a corresponding card in SPB wallet.

 List or tree view of the cards which have website addresses in your wallet to navigate and supply user 
names and passwords automatically.

 Password generator to make a new strong password while registering 
at sites.

 Another powerful feature of SPB Wallet toolbar is the Fill Page button 
which fills currently opened web site user name and password fields if 
it present in a wallet.

Synchronization 
Data synchronization between your device and Desktop can be done via 
Bonjour service. You can also synchronize your wallet with file share, folder, or 
Gmail over the cloud (synchronize wallet with your Gmail account).
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INSTALLATION
Installation of SPB Wallet is a very simple process and takes less than five minutes to complete. The following 
installation guide will help you.

System Requirements
Make sure your system meets the following minimum requirements before installation.

 Desktop Version: Windows 2000 SP3+, 2003, XP, Vista or higher

 Device Version: Apple iPhone 3G, iPhone Original, and iPod touch               

Installing  
You can search and download SPB Wallet from the App Store directly to your device. Applications you download 
and install from the App Store on iPhone or iPod are backed up to your iTunes library until the next time you sync 
the device with your computer. You can also install SPB Wallet through iTunes on your computer when you sync 
with iPhone.

To use the App Store, your device must be connected to the Internet. You will also need an iTunes Store account 
(available in many countries) to purchase and download SPB Wallet. 

Note

Desktop version of SPB Wallet can be purchased at the SPB Software web site:

http://spb.com/iphone-software/wallet/

Uninstalling
If you need to uninstall SPB Wallet software for any reason, follow these instructions:

1. Begin by syncing your iPhone 3G, or iPod touch with your computer.

2. Go to Applications in iTunes’ sync screen (the far left tab).

3. You will see a list of all the programs you have. Those with check marks next to them are installed on your 
device. Uncheck the box next to SPB Wallet to remove the program.

4. Click the Apply button to remove the program.

5. Now you have only removed the program from your device, not permanently deleted. The program will 
still live on your computer and can be installed again. 

http://spb.com/iphone-software/wallet/
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GETTING STARTED  
Use SPB Wallet functions and tools to keep your data safe and organized for quick access. The following guideline 
of SPB Wallet for first time users will help you: 

 The first time SPB Wallet runs you will be asked to create a new wallet or open an existing one. You do 
not need to create a new or another wallet on your device if you create one on your Desktop PC. To 
create your new wallet you will need to specify:

o The name of the wallet file. 

o A password for the new wallet. 

 On your Desktop, there are two ways to enter the 
password. One way is simply entering the password 
by keyboard. Otherwise you can click button 
next to the password field to open the login panel
which will help you against key loggers. As you 
enter the password the scale below shows the 
strength of it.

o The password hint which will remind you of the password if 
forgotten. Please note that this hint is saved unsecured on 
the wallet file, so it may be visible to anyone who attempts 
to access your wallet. 

 Drag up or down to scroll and flick to scroll quickly. Now you can start 
providing your data by selecting the data category (folder) and cards type, (e.g. for credit cards 
information chose Credit Cards category).

 Tap , then add a card, folder, or edit the selected folder.

o Chose your card name and icon then select the associated 
template with this card.

o Fill as many important card property fields as necessary.

o Add any additional information about this card in form of a 
note.

o Customize the appearance of the card. You can either 
inherit the view from a standard template or edit your own 
view using different controls, captions, and images. Tap 
Done when finished editing.
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 To view an added card, select the card folder (category) and tap a card. When you are browsing cards or 
cards list, rotate device sideways to see your card content in full screen mode. Flick left or right to switch 
to another card and tap to view any additional information associated with the selected card.

 If the predefined cards and templates didn’t fit your needs, then access the online templates gallery from 

the templates view. You can search by country, card type, and keywords and then tap Import to 
download the selected card template. An Internet connection is required in order to use the Online 
Templates Gallery feature.

Important

If you change the base template then all the cards based on that template will also be changed.

 On your Desktop PC, you can use SPB Wallet browser toolbar to capture cards automatically of your 
favorite websites. SPB Wallet will ask you to save user name and password of websites automatically 
when you sign in to any website that does not exist in your wallet. Your wallet must be opened in order to 
use the SPB Wallet browser toolbar.

 By synchronizing your new wallet you will have two absolutely identical wallets on both device and 
Desktop. In the synchronization options you can specify what action should be performed in case of an 
item conflict (similar non-synchronized items existing on both the device and desktop parts). On your 
Desktop PC, click the New Sync... button to launch the synchronization type wizard which allows you to 
sync your wallet with folder or network share, Google mailbox (Gmail), and iPhone or iPod using Bonjour 
service. Select the type of synchronization and follow the wizard instructions.

Tip

If you want to move your wallet file to other location and keep it synchronizable follow these steps: 

 Move the wallet file to the new location.

 Open it with SPB Wallet.

 Now the file will be synchronized from the new location.
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FEATURES AND OPTIONS
A lot of features have been implemented in SPB Wallet to satisfy your needs. In this chapter you will find all the 
information you need about the program features and options. 

Quick Search
Select Search and supply symbols to start searching for your card. As you type, SPB Wallet will show you the list of 
cards that contain strings matching your search criteria. The search engine looks for the entered string at any 
position of the card name, field values, and notes. 

Smart Card Fields
The smart card fields are fields which contain phone number, Email, or 
website.  With SPB Wallet smart card fields you can: 

 Make phone calls.

 Send SMS/MMS.

 Send Email.

 Open web sites.

 Open web site with auto fill and the browser will be opened 
automatically with the user name and password filled in the right 
fields on the website page. 

On your device, tap a card field to view the available options.

On your Desktop PC, right-click to open the selected field context menu and 
view the available options.

Wallet Editing
On your device you can edit your wallets file name, change its password, and delete a wallet file. In SPB Wallet 
Welcome screen, Tap Edit Wallets to manage your wallets files.

 Select a wallet then tap its name if you would like to change the name.

 Select a wallet then tap Change Password button to provide a new password.

 Tap to show the Delete button, tapping Delete will remove the selected wallet from your device.
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Sync with Gmail
SPB Wallet on your device allows direct, over-the-air, native synchronization of 
the wallet file with your Google mail account (if available). This feature does 
not need any software installed on your device because it uses synchronization 
protocols that are already built in. Follow these steps to set up Gmail Sync on 
your device:

 Ensure that your Gmail IMAP protocol is enabled. To do that:

o Login your Gmail account.

o Select Settings from the top right corner of your Email 
window.

o Select "Forwarding and POP/IMAP" tab.

o Check "Enable IMAP" at IMAP Access option.

 Make sure you have an Internet connection on your device.

 From SPB Wallet Welcome screen, tap Sync icon.

 Tap Add sync with Gmail.

 Tap Login and supply your Gmail account user name.

 Tap Password and supply your Gmail account password. Save your 
login information if you want.

 Select the wallet file that you would like it to be synchronized.

 Now by tapping Synchronize, SPB Wallet will create a SPB Wallet label 
in your Gmail account and save the selected wallet file into it.
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Sync with Bonjour
SPB Wallet allows direct synchronization of the wallet file between your device and Desktop using Bonjour. This 
feature requires the Bonjour software installation on your Desktop and a WiFi connection. Follow these steps to 
set up Bonjour Sync:

 Download the software on your WiFi enabled computer (if not 
already been installed) from: 
http://www.apple.com/downloads/macosx/apple/windows/bonjourf
orwindows.html

 Double-click the Bonjour installer and follow the onscreen 
instructions. If Java is not present at the time of installation and you 
decide to install Java at a later date, you will need to do a Repair 
install of Bonjour for Windows in order to get the proper Java 
Bonjour libraries. To do a Repair install, go to the Add or Remove 
Programs Control Panel, select Bonjour from the list and click 
Change/Remove. Then choose Repair and follow the onscreen 
instructions.

 After Bonjour is installed on your computer it is ready to use, 
establish a WiFi connection between your device and the computer. 

 Make sure that SPB Wallet is running on both sides.

 On your computer select Tools > Synchronize with > Apple iPhone to start the synchronization wizard.
Then choose Next and follow the onscreen instructions.

Important

The WiFi connection must be established directly between your device and a PC, not through a WiFi spot or router.

Note

If Bonjour Sync didn’t work properly for any reason, please try reinstalling the Bonjour software on your computer.

http://www.apple.com/downloads/macosx/apple/windows/bonjourforwindows.html
http://www.apple.com/downloads/macosx/apple/windows/bonjourforwindows.html
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Password Generator
The Password Generator tool allows you to create random passwords that are 
highly secure and extremely difficult to crack or guess due to an optional 
combination of lower and upper case letters, numbers and punctuation 
symbols. The Password Generator will create the password according to the 
following conditions:

 Password: The result of generating your password will take place in 
this text box. 

 Strength: Select the level of strength of the password, from Normal to 
Very strong. Each level corresponds to a different set of factors (see 
below). If you change those options manually, then the strength level 
is changed to Custom. 

 Length: The number of symbols in the password. 

 User-defined characters only: Here you can enter the set of characters, which will be used in the 
generated password. The more different symbols you enter, the stronger will be the generated password. 

 Different character sets: Selected sets will be present in the generated password. 

 Password is pronounceable: Most of them will be probably pronounceable (using a better combination of 
vowels and consonants). 

Select Generate and the program will generate the password according to your settings. You can generate the 
password several times until you get the right result. 

Backup 
Use the backup feature, on your Desktop, to make a copy of your wallet data so that this additional copy may be 
used to restore the original after a data loss event. All backup copies of the wallet have a backup date/time part in 
their file names, so it will be easy for you to find a backup when you need it. To backup your data select Backup 
Now… menu item. You will be asked for the backup file name and location.

Data Import
The Desktop version of SPB Wallet has the ability to import data from other wallet-kind-applications, including: 

 eWallet.

 FlexWallet.

 CodeWallet.

 SplashID.

 Handy Safe.

 Custom CSV.

During the import, cards from other wallets are linked to predefined templates by special matching engine almost 
automatically. All you need to do is to provide the exported file from other wallet data to the SPB Wallet Migration 
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Wizard. To do so, choose the File > Import menu item and follow the instructions. See the technical support
chapter for more related information.

Integration with Internet Explorer & Firefox
SPB Wallet toolbar is available only on your Desktop version of SPB Wallet. The automatic password support will 
help you to log on your favorite website without the annoying copy/paste of your username and password. Just 
select the website URL on a card and the browser will be opened automatically with the user name and password 
filled in the right fields on the website page.

Go to View > Toolbars menu item to enable or disable the SPB Wallet toolbar.

By using the SPB Wallet toolbar you can:

 Simply navigate to the websites you have in your wallet, with automatic username and password 
supplying. 

 Create cards for SPB Wallet directly from the browser (with automatic capturing of the username, 
password and site address). This can be done both manually by using the Capture Card toolbar button or 
automatically using the Capture cards automatically option if enabled.  

 Generate new strong passwords. 
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 Use Fill Page button to automatically supply the user name and password of the active webpage if already 
been saved in your wallet.

From the Web Browser tab in SPB Wallet options, you can select your default browser, show your web cards with 
folders in the browser toolbar, and enable the automatically capturing of cards option to save user name and 
password of websites automatically when you sign-in to any website that does not exist in your wallet.

Note

The SPB Wallet application must be opened in order to use the SPB Wallet toolbar. However, if your wallet file is 
not started or locked Open operation will be preceded on any button click.

Important

The automated supply of user name and password feature works on your device as well when selecting Open with 
AutoFill option after tapping the website field URL.

Wallet in a Tray
SPB Wallet in Tray is only available on your desktop version of SPB Wallet. The available options when your wallet 
is minimized to the tray are: 

 Password generator. 

 A list of the most used cards you 
have in a wallet.  

 Wallet synchronization. 

 Lock\unlock the wallet. 

 Exit to close the application.

Synchronization
You can start synchronization directly from the SPB Wallet on your Desktop PC by selecting the Synchronize…
command from the menu or clicking the corresponding button in the toolbar.

Click Start to run synchronization according to the configured options. Click Settings... to go to the SPB Wallet 
synchronization settings.

 In the synchronization options you can specify what action should be performed in case of an item conflict 
(similar non-synchronized items existing on both the device and desktop parts).

 To synchronize your wallet data between a device and the Desktop PC, click the New Sync... button to 
launch the synchronization type wizard which allows you to sync your wallet with folder or network share, 
Google mailbox (Gmail), or iPhone using Bonjour service. Select the type of synchronization and follow the 
wizard instructions.

All kinds of data inside the wallet are synchronized without any exception. You can change a template from your 
Desktop, add new graphics or icons, etc, and after synchronization you will have two absolutely identical wallets on 
both sides. 

Note
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Synchronization does not require SPB Wallet to be closed; after the sync is completed the wallet data will be 
reloaded automatically.

Templates Customization Options
SPB Wallet provides over 60 preinstalled templates for you to use in your daily 
life. All templates and cards are fully customizable in SPB Wallet. If they do not 
satisfy your needs you can simply modify a predefined template, create a new 
one, or use the Online Templates Gallery to download from over 7000 
templates right from your Wallet. You also can export templates, so as to 
share them with other users. You may ask SPB Wallet team to make a new 
template for you at http://spb.com/products/wallet/templates  

To use the Online Templates Gallery:

 Open the Online Templates Gallery (an Internet connection is 
required).

 Search by country, card type, and keywords to find the desired 
template.

 Select Import to download the selected card template.

To customize a template:

 Open the template pane on the desktop or choose the Templates on your device.

 Open the desired template for editing.

 Configure fields you would like to be handled by this template.

 Edit view to change the graphical view of the template, change background, fonts, field positions and 
more. 

http://spb.com/products/wallet/templates
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Tip

You can use Reset Default Templates... option in the Tools menu on your Desktop to update and localize your 
templates name, field’s names, graphical view, create new or restore removed templates.

Notes

 When you change the base template then all cards based on that template will also be changed. 

 Only the icon (.ico) format is supported for icons in SPB Wallet. 

 The recommended size of graphics for creating new cards is from 348x243 down to 244x170. Do not use 
big size image(s) to avoid losing storage space on your Device.



SPB Wallet User Manual

Page 17 of 21

Configuring SPB Wallet on Device

You may customize SPB Wallet to Suit your needs. To begin tap , then select SPB Wallet. The options dialog 
includes:

 Security

Here, you can customize options regarding your information security.

o If the Autolock option is enabled, your wallet will be 
automatically locked after the specified period of SPB Wallet 
idle time.

o Enable the Auto Logon option to automatically close the 
password dialog when the correct password is entered.

o If the Hint password after option is enabled, you will be 
shown the password hint that you had chosen after the 
specified number of invalid login attempts. 

 Card View

Enable Show hidden fields option to always show the hidden fields 
such as passwords.  

Configuring SPB Wallet on Desktop
The SPB Wallet configuring options are split among six tabs. To open click Tools > Options… menu item. The option 
dialog includes:

 The General tab configures the general program behavior: 

o Enable the Show Card Graphics option to show all cards with all accompanying images such as 
the background image, otherwise only text information will be shown. 

o Enable the Always show hidden fields option to 
always show hidden fields such as passwords 
fields.

o Disable the Do not show card view fields in card 
properties to see only the data fields on the card 
(duplicated) below the card, otherwise the fields 
will be shown only on the card. 

o Do not sync opened wallet automatically with 
ActiveSync: While synchronizing data between the 
Desktop and a device, all opened windows for 
editing will be closed and reloaded while data is 
applied, and the only way to avoid this is to enable 
this option. 

o Enable Minimize SPB Wallet to tray to 
automatically minimize the current session of SPB
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Wallet to the tray rather than to the taskbar. 

o At "Most Used Cards" view show cards, Select the number of cards you want to see in 
the Most Used Cards pane. 

o Default folder for wallets to provide the folder where your wallets will be stored by default. 

 In the Security tab you can customize options regarding your information security:

o If the Lock wallet automatically after option is enabled, your wallet will be automatically locked 
after the specified period of SPB Wallet idle time.

o If the Show password hint after option is enabled, you will be shown the password hint that you 
had chosen after the specified number of invalid login attempts.

o Enable or disable the Automatically close the 
password dialog when the correct password is 
entered option.

o Enable the Clean up clipboard on exit option to 
clean up the clipboard automatically when you 
exit the program. During your work on the 
program you may forget that you had copied 
some important data to the clipboard. Prevent 
your data from being disclosed by selecting this 
option. Only the data which was copied from SPB
Wallet to your clipboard will be deleted.

 In the Synchronization tab you can configure the 
synchronization of your desktop SPB Wallet with the device
part. Please check which particular wallets you want to be 
synchronized and select the default conflict resolving 
method. 

o Click New Sync... button to launch the synchronization type wizard which allows you to sync your 
wallet with Folder or network share, Google mailbox (Gmail), and iPhone using Bonjour service. 
Select the type of synchronization and follow the wizard instructions.

 In the Web Browser tab you can select your default browser, show your web cards with folders in the 
browser toolbar, and enable the automatic capturing of web cards when you sign in to any new website 
that does not exist in your wallet.

 From the Skin tab you can change the login panel skin and color.

 From the Background tab you can change the background text font and color.
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TECHNICAL SUPPORT
This chapter contains technical support information. It includes all the information you need to assist you.

Before Contacting Technical Support
Please read this section before contacting technical support, it includes most common important issues users 
might face.

Data Import
If you use a localized version of the CodeWallet application you need to switch it to English before exporting data. 
To do so: 

1. Open the registry editor (run regedit.exe).

2. Open the [HKEY_CURRENT_USER\Software\Developer One\CodeWallet Pro 5] key. 

3. Locate the LangPref value in the right pane.

4. SAVE THIS VALUE SOMEWHERE TO RESTORE IT LATER. 

5. Change the value to 409 (hex). 

6. Open CodeWallet. 

7. Proceed with data export. 

8. After exporting data restore the previous value the same way. 

Custom CSV Format allows you to import cards data and folders with hierarchy. 

File must be in CSV format with ANSI-encoding and must have CSV extension. Delimiter "," is used in CSV. 

Folder record format: 
Column 1: "Category:" keyword 
Column 2: Folder type == name of default folder template (must be same with template name at SPB Wallet, 
please take care of spaces). 
Column 3: Folder name. (Must include all parent folders divided by "/" symbol).

Cards for folder must follow the folder description. 

Card record format: 
Column 1: "Card:" keyword 
Column 2: card template (must be same with template name at SPB Wallet, please take care of spaces) 
Column 3: Card name

Card fields and notes must follow the card record. 

Card field record: 
Column 1: "Field:" keyword 
Column 2: Field type, must be the same with field type at SPB Wallet template 
Column 3: Field value
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Card comment record: 
Column 1: "Notes:" keyword 
Column 2: Notes text

Sample CSV file: 

Code: 

Category:,Cards: Calling Card,Personal Info 

Card:,Cards: Library Card,My Library Card 
Field:,Library, 
Field:,Card #,23435 
Field:,PIN/Code,3345 
Field:,Phone,555-55-55 
Field:,Address,Street 
Field:,Hours,"""Test""" 
Field:,Web Site,www.lib.com 
Field:,User Name,User1 
Field:,Password,Password1 
Notes:,My library card 

Category:,Cards: ID Card,Personal Info/IDs 
Card:,Cards: ID Card,My ID 
Field:,Card Title,1 
Field:,Full Name,2 
Field:,ID #,3 
Field:,Country,4 
Field:,Phone,5 
Field:,PIN,6

Username or Password is Not Supplied Automatically while Opening the Website
Automatic password supplying may not work if there are some special requirements made by site developers to 
make authorization more secure (like using special Java or Flash applets, etc). 

Please report information about these site(s) to the SPB support team to get more information.
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Contacting Technical Support
Please take advantage of one of the SPB software free technical support options:

 Refer to the Frequently Asked Questions (FAQs) in the support section of the SPB Software web site. The 
FAQs may have information and helpful hints that are more current than the user manual:
http://spb.com/pocketpc-software/wallet/faq.html

 Ask the SPB Technical Support a question here: 
http://spb.com/iphone-software/wallet/support.html

Please include the following information to help us isolate the 
problem:

1. The type of the device that you are using. 

2. The software version number. Go to the About screen from 
the welcome screen to view the software name and version 
number (example: SPB Wallet, version 2.0, Build 10048).

3. Any error messages that accompany the problem.

4. A brief description of how we can recreate the issue.

http://spb.com/pocketpc-software/wallet/faq.html
http://spb.com/iphone-software/wallet/support.html

